
Becky! Internet Mail for Windows® 95

Becky! is a multi-featured Internet E-mail client for Windows 95.
You will find many useful functions which are expected for an E-mail software and some
of them are beyond your expectation!

Features:
Windows Explorer like look & feel

Multiple accounts management: You can manage multiple mail accounts up to 20,
and switch to each of them quickly.

You can do every operation, except sending and receiving, off line.

Powerful text editor: Highly-functional text editor engine is incorporated for 
reading and writing messages. You do not have to compromise in editing 
capabilities for E-mail software.

Mail box management: You can create your own mail folders to put messages. 
You can define "Filter" rule to move messages to specified folders 
automatically.

MIME compatible binary file attachment. (BinHex and uuencode are supported as
well as Base64)

Outbox capability: You can save composed messages you want to send    later 
into the "Outbox" . "Deliver" command sends all messages in the Outbox of all 
accounts.

Draft capability: You can save incomplete messages into the "Draft Box" for 
polishing them later.

Reminder capability: You can send messages to "yourself" in order to remind 
some important (but forgettable) things. Those messages are delivered on 
specified date.

Clickable URL and E-mail address: If URL or E-mail addresses are found in a E-
mail message, it is shown in a different color. Double clicking URL lets the URL 
activate in WWW browser. And double clicking E-mail address opens a 
compose window.

Url-encoded messages which are posted from WWW form are automatically 
decoded when receiving.

PGP front end. (work with PGP 2.6. Encoding attachment files is not supported)

Incorporated HTML viewer. (needs MS Internet Explorer 3.0 or higher)



Voice E-mail capability: You can record and attach GSM6.10 format of small WAV 
files with your message. (Recipients need to use Window95 or WindowsNT4.0 
with audio compression manager for playing back them.)

Auto responding and forwarding: You can customize auto responding feature 
using Filtering Manager and templates.



Getting Started

When you run Becky! for the first time, you will be prompted to specify the folder where Becky! will create 
mailboxes and place other system files.
Default folder name you will see in the dialog box is the application folder + your Windows logon name. 
We recommend you to use this default folder name because Becky! has each setting for each Windows 
logon user.

Next, you will be prompted to set up your default mail account.
Fill out the information in the "Accounts" property page;
Name, E-mail, POP server, SMTP server, POP UserID, and Password(if you want). These settings are 
needed for sending and receiving your E-mail.

#If you want to move the mailbox folder after that, 1) Exit Becky!, 2) Move (or rename) the old folder to 
new one by using Windows Explorer, and 3) Restart Becky!. You will be prompted to specify the name of 
the folder again. Then specify the name of the new folder.



Main window

The main window of Becky! is consist of three 'panes'.
The tree view pane(left), the list view pane(upper-right), and the message view pane(lower-right).

The tree pane shows mail folders, the list pane shows messages in the folder, and the message pane 
shows the body of the message.

You can read messages using cursor key, page up/down key, and home/end key like when you use a text 
editor.
And, Hitting Alt+Up/Down key allows you to read next/previous message continuously.
(It would be useful when you are glancing over a lot of messages.)

Tree view pane

You have three folders initially: Inbox, Outbox, and Trash.

The "Inbox" contains incoming messages.

The "Outbox" contains outgoing messages which you have composed and saved by "Save to Outbox" 
command. And they will be sent when you select "Deliver" command. You can also deliver when you are 
receiving messages by checking "Deliver on Receive" option in the "Receive" property. By this option, 
Becky!'s "Receive" command acts like "Send and Receive" command.

You will find three sub folders under the Outbox: Sent, Draft, and Reminder.
The messages you have sent are moved to the "Sent" box. By double clicking one of those items, you 
can re-edit and send it again.
The "Draft" box contains incomplete messages you have saved by "Save to Draft box" command in the 
composing window. You can re-edit those messages and send them later.
The "Reminder" contains messages you have saved by "Reminder" command. "Reminder" is special 
messages which is delivered to yourself on the specified date.

The "Trash" box contains deleted items which you have deleted by "Delete" command or Delete key. By 
checking "Empty TrashBox on Exit" in the "Receive" property, Trash box will be cleaned up automatically 
when you are exiting the program.
"Empty Trash box" command is also available in the right mouse button menu of the tree view.

You can create new folder by "New Letter Folder" command to organize your incoming messages. To 
create sub folders, select a folder and select "New Letter Folder" command.

You will see other mail accounts at the bottom of the tree if you have configured other mail accounts in 
"Accounts' property.You can switch the current mail account at once by clicking one of them.
These icons are also targets of drag and drop. Messages can be dropped to another account. They will 
be put into the Inbox of the target account.

List view pane

In the list view pane, the messages in the selected mail folder are listed.
They are in the date-descendant order initially. It can be switched to the message-tree order, which is 
useful to read messages from mailing lists, by the "Thread mode" command (in right click menu). This 
mode can be set individually for each folder.

After moved or copied mail items from a folder to a folder, the order of messages may be upset. In this 
case, use "Reorganize" command.



Sometimes, you will see diode-like icons at the left of the mail items. It represents the priority of the 
messages. Red represents the highest priority and in the order of priority, they may turn to yellow, 
transparent, green, and blue. (blue represents the lowest priority). These priority indicators are initially set 
by the sender of messages, but you can change them as you like by double clicking or right mouse button
clicking these icons.

Read, Unread, Forwarded, and Replied mail
The unread mail is the one which you have received and have not read yet. It is represented by a 
sealed envelope icon. 
They will be turn to the read mail by one of the following operations.

n Double clicking the item.
n Set focus to the message view.
n Read them using Alt + Up/Down key from the message view pane.
n Read them using left/right arrow icon at the above of the message view pane.
n Select "Set Read" command in the "Tool" menu.
n Entire message is shown in the view pane.

They are not set read only by clicking the mail item in the list unless entire message is shown.

The "read mail" is the one which you have read. It is represented by an opened envelope. They will 
be set unread by the following operation.

n Select "Set Unread" command in the "Tool" menu.

The replied mail is the one which you have replied. It is represented by an opened envelope with 
another new envelope. They are set by sending or saving to Outbox the reply mail to that mail. 
The forwarded mail is the one which you have forwarded to other addresses. The forwarded mail icon
has a little blue arrow.

Message view pane

In the message view pane, the content of a selected mail item in the list is shown.
URL and E-mail addresses are shown in the other color and double clicking them, you can write to the 
address, or open the URL by a Web browser.
(Clickable URL & E-mail)

Messages can be edit by "Edit Message" command in the "Mail" menu.
You can save a message as a text file quickly by "Save As " command in the right mouse button menu. 
"Export" command gives you various options for saving multiple messages.

There is a border area which shows Subject, Date, and From between the message view pane and the 
list view pane. This is called "middle bar".
By Double clicking the middle bar, you can let the view window maximize or restore.
Also, the following command buttons are in it.

1) Check Addresses: Shows the addresses such as From, To, Sender, Cc, and Reply-To and you
can add them to the address book from there. Also you can specify the 
address to reply if you would like to reply to the other address rather than 
the sender.

2) Header Information: Shows the information of the mail header of the selected mail item.
3) Left/right arrow button: Read next/previous messages. With the Shift key, you can read 



next/previous unread messages. With the Ctrl key, you can move the 
cursor at the top/end of the list.

4) Up/down arrow button: Scrolling up/down the message one page.



Receiving messages

To receive messages, select "Mail" -> "Receive" command.
The mail animation at the upper-right of the window starts moving. When checking mail is finished, the 
animation stops. If you got new messages, you can hear a prompting sound (you can choose your 
favorite sound for this in "Receive" property).

Filtering

Incoming messages are moved to the specified folder which you have defined in the "Filtering Manager".
If you would like to have incoming messages in Inbox and filter them later, uncheck the "Auto Filtering" 
option in the "Receive" property. You can filter them by "Filtering" command in the "Tool" menu or 
checking "Filter on Exit" in order to filter them when you are exiting the program.

Attachments

If you have attachment files with incoming messages, you will see icons at the right of the message view 
pane. Double clicking them, you can launch the application for the file or save to somewhere on your 
harddisk.
If you received .doc or .xls type of file, it's not a good idea to double click them immediately. 
Because those kinds of files might contain 'macro virus'. Check them whether they contain any 
virus or not first.

Becky! also supports uuencoded and BinHex encoded files. The former one is popular in UNIX and latter 
one is widely used for Macintosh.

Becky! decode those files when they are received, but there still remain original uuencoded files or 
BinHex files in the attachment pane. You will have two icons eventually: the encoded file and the decoded
file.
Because those encoding formats include platform specific information for UNIX and Macintosh. So, for 
example, if you received BinHex files from a Macintosh user and you would like to forward them to 
another Macintosh user, delete the decoded file from the attachment in the composing window and send 
only the original BinHex file('hqx' file type). (No matter which encoding method is selected in the 
composing window, it is sent as a BinHex file.)

If those encoded files are sent in the MIME multipart message as the "application/x-uuencode" or the 
"application/mac-binhex40" MIME type, they are automatically decoded. But if not in the MIME, you have 
to decode them manually by decoding command in the "Tool" menu.



Sending messages

Sending new message

To send new message, select "Mail" -> "Compose". You can also open composing window by selecting E-
mail address in "Tools"->"Address Book".

After writing a message, fill the "To:" field and the "Subject:" field.
You can input E-mail address from the address book which opens when you click the "To:" button. You 
must input the "To:" field except when you are saving the message as a template, a reminder, or a draft. 
The "Subject:" field could be left blank but it is recommended to specify a subject so that recipients have 
some idea when they receive your mail.

"Cc:", "Bcc:", "Attach", and "Others" are optional.

Select "Message"->"Send" to send the message immediately.

If you want to send the message later, select "Save to Outbox".

If you want to rewrite the message later, select "Save to Draft box".

If you want to send the message to yourself at a certain date, select "Reminder" and specify the date 
when you want to receive it.

You can save the message as a template which can be reused next time.

Replying

To reply to the received message, select "Mail" -> "Reply" or "Reply All" command highlighting a message
you want to reply. You will see the composing window split into two panes.

Upper pane is called "reference window" which you can refer and cite entire or part of the original 

message. Alt+Up/Down key to scroll the reference window.
Lower pane is the editing window where you can write a message to be sent.

If you have checked the "Cite on Reply" in the "Compose" property, entire message will be automatically 
quoted when you open a replying window. If you don't like the split window, you can choose "Hide 
Reference Window" option as well.

Forwarding

You can forward incoming messages to another person by "Forward" command.
The forwarding command has three different modes of which you can choose.

First one; you can send the forwarding message "from you" so that the recipient can receive this 
message as the message sent from you. "From:" field shows up your address and "To:" field shows up 
the recipient's address. The recipient will reply of the message to you

In the other two mode, the forwarded message remains original "From" , "To" fields, so you should 
be careful because if the person who got the forwarded mail from you reply to the message, the reply will 
go to the original sender, not you.
If you select "Redirect", the forwarding message has no "Fw:" prefix on the subject and original message 
will be sent. It would be useful when you would like to send the message which you have received 
somewhere else to your permanent mail address, or you would like to forward the message to whom the 



message would concern.

If you receive these kinds of forwarding message by Becky!, you will be able to choose the address who 
is supposed to receive the reply message for the forwarded mail.
Because Becky! checks "Resent-From" and other "Resent-" headers in the forwarded messages.

Sending again

If you would like to resend the mail which you have already sent, double click the message in the "Sent" 
box. You can edit and send it again.
The messages which are not sent for an error will be also saved in the "Sent" box. You can select the 
messages, correct errors, and send it again. In most cases, the error is that the mail address may contain 
invalid characters or have unmatched braces.

Setting priority

You can set priority for outgoing message in 5 degree. Click the stamp icon at the upper-right of the 
composing window and select the priority.
The priority may be ignored by some mailers. Or some mailers only recognize 3 degree of priority. In this 
case, the 1,2 and 4,5 may be treated as the same priority.

When you receive the mail with those priority information, the priority is represented by the diode-figured 
icon at the left of mail item list.



Cc and Bcc

"Cc:" stands for "carbon copy". If you want other people whom this message does not directly concern to 
read the message, specify the addresses of them in “Cc:”.
"Bcc:" stands for "blind carbon copy". It is almost the same as "Cc:" in the way it works. But recipients can
not see the addresses specified in Bcc.



Attachment

You can attach binary files such as an Excel worksheet to your message by "Attach" command.
Attached files are seen as icons at the bottom-right of the compose window.
Note that the attachment is just a link to an original file. If you delete the attachment using delete key, the 
original file is not deleted except when those files are located in 'Attach' folder. Attach folder contains 
attachment files you have received from others. 



Others

"Others" command is to add certain header fields you want. Only the users who are familiar with the 
Internet E-mail headers which are defined in RFC822 may use this command.
You can also change 'From' field here.



User Preferences

To configure Becky! , use "Tools" -> Preferences command.
The Preferences dialog contains the following tabs.

Accounts
Compose
Receive
Send
View
MIME 
Misc.



Send

Send From Outbox Configure the action of "Send from Outbox" command

- Send from All OutBoxes via Each SMTP Server
Send all messages in the Outbox of all accounts using each SMTP server of each account.

- Send from All OutBoxes via Current SMTP Server
Send all messages in the Outbox of all accounts using a SMTP server of the current account.

- Send from Current OutBox Only
Send messages in the Outbox of the current account. Messages in Outbox of other accounts 
will not be sent.

Send 'Date' Field Send date information of your PC's system time with time zone information. It 
should be checked only when your provider's SMTP server doesn't add 'Date' 
field to outgoing messages or the provider's date and/or time zone information 
is incorrect from your location.

Send 'Message-Id' field Usually you do not have to check this option. Generally, the Message-Id field 
should be added by a server. It, however, would be useful when you filter your 
sent messages and want to keep messages threaded.

Check New Mail after 'Send Now'
For dialup users, the 'Send Now' command in the composing window does 
connect via dial up network and send the current message and then disconnect
immediately. If you want to check new messages when you select the 'Send 
Now' command, check this option.

Confirm Recipients Before Sending
Usually, you will see the confirmation dialog when you select 'Send Now' or 
'Save To Outbox'. command leaving blank the 'To' or 'Subject'.
This option let the dialog always pop up when you select sending command.

Filter Sent Messages After Sending
If you check this option, your outgoing message will be filtered according to 
your filtering rule instead of being stored to 'Sent' box.



Accounts

Account Select an account to be configured.

Default Account Set this account as your primary account.

Your Name Specify your real name.

Mail Address Specify your mail address. (user@domain)

POP Server Specify the name of the pop server on which you have a mailbox. If your Internet 
provider simply says "The mail server is mail.blah.net", that's it.

SMTP Server Specify the SMTP server name of your Internet provider. If your provider does not 
mention about SMTP server, the "mail server" should be the SMTP server. In most 
cases, POP server and SMTP server is same.

POP User ID Your Login name for the mail server

Password Your Login password for the mail server. For better security, it should be left blank. 
If it is not specified, you will be prompted to input password    when you are 
checking mail.

Mail Box Specify the mail box number. Usually it should be the same as the account number
so that each mail account has its own mailbox separately. If you want to share one 
mail box by multiple accounts, specify it as the same number of the other.
If you choose the same number through multiple account, it means those 
account 'share' the same mailbox. It doesn't mean each account has 
duplicate data.

Signature Specify your signature number. You may have multiple signature up to 20 and can 
edit in "Compose" property page.

Do Not Leave Messages On Server
Specify to delete messages on the POP server after retrieving. This option should 
be checked in most cases.
Suppose you use Becky! at your office and home, and you want to read your 
private mail mainly at home but just want to check them at office. You should check
this option for your home PC's and uncheck for office PC's so that you can receive 
the same mail both at office and home.

Description Short description for the account. It will be seen on "Account" combo box, "Switch 
User" command, and the caption of the main window.

Filter You can specify the "Filter" rules to sort messages into specified folders 
automatically.

Connection Configure the connection to the Internet.

Misc. Some other settings such as the permanent Cc, and default templates. "Use 
APOP" option is also here.

Advanced You can specify the port number for POP3 and SMTP. Only when your provider 
uses the port number other than the standard port, specify them.
Some delegate server may require non-standard port number.





Connection
Specify the connection method. If "Dial up network" is specified, Becky! will 
automatically dial up to the specified provider when you are sending or receiving 
mail.

Auto Hangup Check this to hang up at the end of a session.

Authentication Specify the dial up user ID and the password. In most cases, "Retrieve from the 
dial up definition" would work fine. But if you haven't installed Microsoft Network on 
your Windows95 system, "Save password" option in the dial up network will be 
unavailable. In this case, you may choose one of the other two options; setting as 
the same as POP account, or specifying your user id and password in the text box 
directly.



Filter

Filtering

Swamped with mail? Becky! can automatically sort incoming messages into particular folders, forward 
them to someone else, or even reply to them. All you have to do is lay down some if...then rules based on
matches between a particular header line and a particular string.

Perhaps the simplest application is sorting e-mail from a mailing list into its own folder. More advanced 
applications include sending spam straight to the Trash or, using a template, automatically sending it back
unopened.

For even finer control over sorting, a rule can optionally have a second condition joined to the first with the
Boolean operators And (both) or Or (either).

Rules apply in the order given in the list box.

Header Specify the header line to search.

Find Specify the string to search for in that header line.

MoveTo Specify the folder to receive each message for which the specified header line 
contains the specified string. Alternatively, select the pseudo-folder 'Set Color' and 
specify a color for the message, and leave it in the current folder.

NoCase Check this to ignore the distinction between upper and lower case.

Not Check this for a match when the string is NOT found.

Add Add the rule to the bottom of the list.

Insert Insert the rule before the currently selected rule in the list.

Replace Replace the currently selected rule with the new definition.

Del Delete the currently selected rule.

Up/Down Adjust rule priority by moving the currently selected rule in the specified direction.

Reply Available only for the destination folder 'Outbox', this option generates an 
automated reply to the message using the specified template.

Forward Available only for the destination folder 'Outbox', this option forwards the incoming 
message to the specified address using the specified template. Note that the 
address in the template, if present, takes precedence.

Unlike other conditions, every condition for Reply/Forward is executed regardless the order in the 
list. And for 'Set Color' , the last hit condition will be effective.



Compose

Citation Prefix Specify a string which will be added at the top of the cited strings.

e.g.
If '>' is specified,

> This is a original message.

If '->',

-> This is a original message.

With Name Check this if you want the sender's name (actually a left part of his/her E-mail 
address) to be added with the citation prefix.

e.g.
If the original message is from "john@blahblah.com" and the citation prefix is '>',

john> This is a original message.

With "Real" Name Use the first name of the real name instead of using a part of e-mail address.

e.g.
If the original message is from "Johnny B. Good <john@blahblah.com>" and the citation prefix is '>',

Johnny> This is a original message.

Cite on Reply Check this if you want an original message to be automatically cited when you 
select "Reply" command.

Hide Reference Window
The 'Reply' window shows split windows. The upper pane shows the original 
message you are replying. If you think it is annoying or would like to use the 
compose window widely, check this option.

Add Reply Number To Subject
If it is checked, 'Re[2]:', 'Re[3]:'... prefix is added to the subject of your replying 
message. If not checked, only 'Re:' is added.

Signature Select the number of the signature you want to edit. You can have multiple 
signatures up to ten.

Comment Input short description for the selected signature. This comments will show up in 
the Compose window to choose signature.

Reply Header Customize the header text when you cite the entire message on replying. Following
macro symbols are supported.
%f From: field
%i Message-Id field
%d Date: field
%s Subject: field
%t To: field
%n name extracted from the From: field
%a mail address extracted from the From: field



%% % itself.



Receive

Every/Never Check this to check your new mail periodically. If "Every" is selected, you also have
to specify the period of time in minutes.

On Startup Check this to check your mail when the program is started.

Do Not Check When Off Line
Check this to have Becky! check mail only when Dial up Network is active. You will 
need to configure the connection to dialup in the Connection setting in the Account 
property.

Popup When Received
Check this to have Becky! pop up when new messages arrive.

Message box Notification
Check this if you want to be notified by a message box when you have new mail.

Chec&k All Accounts Which Share Current MailBox
Check this to check multiple accounts which 'share' same mailbox number by 
single 'Receive' command or periodical check.
To 'share' same mailbox number, specify the same number for 'MailBox' in ' 
Accounts' property for each mail account.

Sound Specify a sound file you want to hear when new messages arrive.

Empty TrashBox on Exit
Check this to empty the Trash Box when exiting the program.

Warn If OutBox is not Empty on Exit
Check this if you want to be warned if there are messages left in OutBox when 
exiting the program.

Filter on Exit Check this to do filtering automatically when you are exiting the program.

Deliver on Receive Check this to deliver messages in OutBox before receive new messages.

Auto Filtering Check this if you want to do filtering automatically when you received mail.    'Set 
Color' conditions will be done automatically even if this option is not checked.

Select First Incoming Message
Check this if you want first new message to be selected.

Wrap Long Line Automatically
When you receive a message which contains long lines more than approx. 80 
columns, This option make them to be wrapped automatically when receiving.



View

E-mail Specify the action when an E-mail address in a message is double clicked.
    Mail To Open the compose window to the address
    Add to Address Book Add the address to the address book
    Copy Address Highlight the address and copy to clipboard.
    Highlight Word Highlight the word. Do nothing special for an E-mail      address.

URL Specify the action when an URL in a message is double clicked.
    Open URL Open this URL in the browser. If Netscape is not running, the program 

which is related with ".html" file type is launched.
    Copy URL Highlight the URL and copy to clipboard.
    Highlight Word Highlight the word. Do nothing special for an URL.

Spacebar Scrolling
You can read unread messages continuously with scrolling by hitting spacebar. This configures the 
mode of scrolling of that.

Smooth Roll up text
Skip Page up text

Half Page Scroll half of a page.

Choose Font Change the font for text, printer, and the status bar. The font of the status bar is not
changed until you restart the program.

Show ToolTips Show tooltips when you locate the mouse pointer on a toolbar button.

Long Tree View Make the tree (folder) view a long window. If it is not checked, the mail view is 
shown widely instead.

Turn Off Control Characters
Make the control characters like CRLF, Tab, etc. invisible in the edit window.

View Window is Maximized Only Vertically
You can usually maximize the view window by double clicking the 'middle bar'. This
option makes the view to be maximized only vertically so that you can still see the 
folder window.
It is effective only when you have checked the 'Long Tree View' option.

Mail View Color Change colors in View window. You can choose one of the colors in combo box. 
Clicking 'Custom' button let you have more flexible color setting. This setting is 
effective only for 'Mail View Pane'. You can not change colors either in Tree View
nor List View.



MIME

You can define an action for each MIME type for attachment files here.

MIME Type/Sub type Selected MIME type is shown. You can add new MIME type by hitting "New" 
button. You can delete the type you added by hitting delete key on the list. The 
types initially specified by Becky! can not be deleted. They look deleted if you hit 
delete key, but it will revive when you restart the program.

Extension Specify the default file type for the selected MIME type.

Action Specify an action for double clicking. If you get mail with MIME compatible files, 
you can see icons of attachment files at the bottom right of the main window. 
They can be opened by another application or saved.
Select one of the following actions.

    Default Launch the application which is related with the extension of the file at first. If no 
application is related, the file is saved.

    Save Save the file.
    Launch Application Launch the specified application which can open the file.



Misc.

Spell Check You can select the mode of spell checker whether American English, British 
English, or the both.

Local Password If you want to keep any other person away opening your Becky! and reading 
mail while you are having lunch, specify the password. However, keep in mind 
that the mailbox files are still plain text files, so this capability never give a good
security.

Input When Restoring from Icon
You will be prompted to input password when you are restoring the program from
the icon.

Mark Read Even If Entire Message Is Not Shown.
As default, when you select a message in the item view and it is now shown 
entirely, the message is not marked read until when the entire message is shown.
If you want to mark read every message you select in the item list, check this 
option.

View HTML mail (needs MSIE3.0 or higher installed)
When you receive HTML mail you can read it in the Becky!'s window. But it will 
take several seconds to bring up the ActiveX component for the first time or 
sometimes this capability conflicts with your environment.
If you experience a problem, uncheck this option.

Voice Recording
    Real Time Compression

Check this if you want WAV file to be compressed real time while you are 
recording. Sometimes your PC doesn't have enough power to support real time 
compression. If you have some problem with voice recording, uncheck this 
option.

Advanced Settings
    Receive Buffer for Socket Larger

Usually you should not check this option. It might cause a problem in some case. 
If Becky! stops sending or receiving too often during the session, try this option.



Using Editor

Becky! incorporates a subset of the highly-functional text editor Dana.
(Dana is one of the products by RimArts. )

Dana enable you to edit and view huge text quickly with ease for its great performance and a lot of useful 
functions.
Most of functions can be seen in “Edit” menu, and others are bound to certain keys strokes.

If you are an user of Dana you can use some of settings including key binds which you customized in 
Dana by defining "DANAHOME" environment variable.
For more information about "DANAHOME", see the help of Dana. (Getting started -> Initial settings)

If not, you can also customize some of settings by editing Rebecca.INI.

Followings are the functions of the Editor and its key binds.
(Ctrl+Q^F means hit Ctrl+Q at first and hit Ctrl+F next)

*Cursor
Cursor up Up
Cursor left Left
Cursor right Right
Cursor down Down
Word left Ctrl+Left
Word right Ctrl+Right
Beginning of line Home
End of line End
Left side of window Alt+Home
Right side of window Alt+End

*Line edit
Back space BS
Delete a character Delete
Input a control code Ctrl+[
Insert a tab code Tab
Flip upper/lower case of a word Ctrl+K^L
Flip upper/lower case of a character Ctrl+L
Delete here to end of line Ctrl+Del
Delete here to top of line Ctrl+BS
Back space a word Shift+BS
Delete a word Shift+Del
Repeat a character Shift+Alt+Insert
Paste the find string Ctrl+Q^I
Paste the time stamp Ctrl+K^T
Input enter Enter
Delete line and stack on the line buffer Ctrl+E
Insert empty line after the current line Shift+Enter
Insert empty line before the current line Ctrl+Enter
Duplicate the current line Ctrl+I
Mark the current line or the selection Ctrl+Q^K
Erase the mark Ctrl+Q^\
Get a deleted line from the line stack Ctrl+U
Toggle insert mode Insert
Toggle word wrap mode Ctrl+K^J

*Edit



Begin selecting Ctrl+K^B
Begin box mode selecting Ctrl+K^M
Paste a box Ctrl+K^I
Paste Ctrl+V
Paste from History Ctrl+K^G
Copy Ctrl+C
Cut Ctrl+X
Undo Ctrl+Z
Redo Ctrl+Y
Repeat Ctrl+R
Step Undo and Redo Ctrl+D
Convert (not assigned)
Center (not assigned)
Left (not assigned)
Right (not assigned)
Sort (not assigned)
Indent Tab (Highlighted)
UnIndent Shift+Tab (Highlighted)
Add string (not assigned)
Select All Ctrl+A
Copy to File Ctrl+K^C
Paste From File Ctrl+K^V
Append File Ctrl+K^]

*Scrolling
Roll up another pane Alt+Down
Roll down another pane Alt+Up
Page up Page Up
Page down Page Down
Roll left Alt+Left
Roll right Alt+Right
Slow roll up Ctrl+Down
Slow roll down Ctrl+Up

*Jump
Make top Ctrl+Q^E
Make bottom Ctrl+Q^X
Make middle Ctrl+Q^D
Top of text Ctrl+Home, Ctrl+Q^R
Bottom of text Ctrl+End, Ctrl+Q^C
Jump to Ctrl+J
Previous position Ctrl+Q^P
Next mark Ctrl+Page Down
Previous mark Ctrl+Page Up
Next changed line F8
Previous changed line Shift+F8
Top of screen Ctrl+Q^W
Bottom of screen Ctrl+Q^Z
Match brace Ctrl+]

*Find
Find forward Ctrl+F, Ctrl+Q^F
Find backward Ctrl+B, Ctrl+Q^B
Find next F3
Find previous Shift+F3
Replace Ctrl+Q^A



Replace again Ctrl+Q^S
Get cursor word Ctrl+_(under score)

Clickable URL and E-mail

If there are URLs or E-mail addresses in a message, they are shown in different color. By double clicking 
it, a particular action for the address will arise which is specified in the "View" property.
You can also select one of the actions in the right mouse button menu which is opened when you are 
focusing the mouse cursor on an URL or an E-mail address.



Undo

Undo the previous editing on the current message.



Redo

Redo the previously undone editing.



Repeat

Repeat previous input command.



Step Undo and Redo

Undo and Redo by steps you specified.

For example, inputting a character can be undone one by one. You can specify number of characters you 

want to undo.



Cut

Cut the selection and copy to the clipboard.



Copy

Copy the selection to the clipboard.



Paste

Paste text from the clipboard to the caret position.



Paste from History

Paste the text which has been cut or copied before selecting from the list.



Box Select Begin

Begin the box mode selecting.

You can cut or copy the selection by Cut, Copy command.



Box Paste

Paste the text data which has been cut or copied in box mode.



Select All

Select the entire text in the editor, or all the items in the list.



Convert

Convert the selection as follows

Case

    No Conversion No operation.

    UPPER ALL All the characters in the selection to upper case.

    lower all All the characters in the selection to lower case.

    Upper top of line A character at the top of the line to upper case.

    Upper Top Of Word A character at the top of the word to upper case.

Tab and Space

    No Conversion No operation.

    Tab to Space All the tab characters in the selection to whitespaces regarding tab columns.

    Space to Tab All the whitespaces in the selection to tab characters regarding tab columns 

as long as possible.



Paragraph

Execute following paragraph editing command.

The one line is assumed to be one *logical* line. (The end of line is a return code.)

LeftRightCenteredIndentUnIndentAdd StringSortReformat



Left

Move the selected lines to the leftside of the columns.



Right

Move the selected lines to the rightside of the columns.



Centered

Move the selected lines to the center of the columns.



Indent

Indent the selected lines one level.



UnIndent

Back indent the selected lines one level.



Add String

Insert a specified string at the top or end of each selected string.



Sort

Sort the selection by ascendant or descendant order.

You can select the following option.

Case Insensitive: Comparing string ignoring upper/lower case. 'A' and 'a' are treated as the same.

Sort Lines: This option can be selected when you are selecting text in the box mode. If this 

option is not checked, only inside of the block is sorted. If checked, the box 

selection is treated as sort keys and entire lines are sorted.

    e.g.

1000 Jane

1001 Michael

1002 Peter

1003 Billy

1004 Amanda

If you select the names in box mode, the result of sorting should be the following.

1004 Amanda

1003 Billy

1000 Jane

1001 Michael

1002 Peter



Reformat

Re format the current selection regarding word wrapping.

Wordwrap mode is useful for writing but if you are proofing text, it is annoying to trim each end of line by 

hand. You can use this function for that purpose.



Copy to File

Save the selection as a file.



Append to File

Append the selection to an existing file.



Paste from File

Insert a file at the caret position.



Cite Original Message

Cite the original message from the reference window when you are writing reply message.

You can cite entire text or the selection.

When you cited entire text, the following description is added.

At [Fri, 7 Jun 1996 17:37:24 -0700]

foo@baa.net (Foo Baa) wrote:



Cite Without Prefix

Cite the original message from the reference window when replying.

This command does not add citation prefix which is defined in the “Compose” preference.



Find

Find specified string in forward/backward direction.

Find String A string you want to search. '\' character is the escape character .

From Beginning of Text Start searching from the top of the current message.

All Messages in Folder: Search in all messages in the folder.

Mark Found Line Set bookmark on a line which includes the matched strings.

Match Whole Word Match a string whose before and after character is a white space or one of 

the delimiting characters.

Match Top of Line Match a string which is at the top of the line. 

Ignore Case Search with no upper/lower case sensitivity.

Regular Expression Use regular expressions  for the find string.

Mark All Search in a whole text and mark all the found lines at once.

Save Option Save this condition as the default setting.



Find in Header

Find specified string in header information of mail items.

You can continue to find by 'Find Next' and 'Find Previous' command.



Replace

Replace found strings to specified strings.

Find String A string you want to search. '\' character is the escape character .

Replace String: A String you want to replace.

From Beginning of Text: Start searching from the top of the current message.

All Messages in Folder: Search in all messages in the folder.

Mark Replaced Line: Set bookmark on the line which includes the replaced strings.

Match Whole Word: Match a string whose before and after character is a white space or one of 

the delimiting characters.

Match Top of Line: Match a string which is at the top of the line. 

Ignore Case: Search with no upper/lower case sensitivity.

Regular Expression Use regular expressions  for the find string.

Replace All: Find and Replace in a whole text at once.

Save Option: Save this condition as the default setting.



Jump To

Move caret to the position which is specified by line number.



Top of Text

Move caret to the top of the text.



Bottom of Text

Move caret to the bottom of the text



Thread mode

Change the order of mail items from recent order to threaded order which older messages are upper and 

each reply message follows the original message. It    is useful when you read the messages from mailing 

lists.

For example, If you have these messages in your inbox(newer is upper) ...

Re: Octopus

Re: So what?

Re: Octopus

Octopus 

Re: I like it!

So what?

I like it!

It will be like this in the thread order.

I like it!

Re: I like it!

So what?

Re: So what?

Octopus 

Re: Octopus

Re: Octopus



Escape Characters

\t Tab

\n Line feed

\b Bell

\f Form feed

\e Escape

\r Carriage return

\0 Null

\xXX Control code represented by XX (0x01 to 0x1f)

\\ '\' itself



Regular Expressions

The following expressions are supported.

^ Match the top of a line.

$ Match the end of a line.

X|Y Match X or YiX,Y is a regular expression)

[A-Z] Match a character between A and Z. (A, Z is a certain character)

[^A-Z] Match a character which is not included between A and Z.

[ABC] Match a character one of the characters "ABC". (A,B,C is a certain character)

[^ABC] Match a character not one of the characters "ABC".

. Match any one character.

X* Match zero or more repeat of X. (X is a regular expression)

X+ Match one or more repeat of X.

X? Match X or empty string.

A regular expression between () has higher priority of operation.



Remove Duplicate Messages

Find messages which has the same Message-Id in the current folder. If matched, the duplicate messages 

are moved to Trash box.



Receive

Receive new messages.

Receiving messages



Deliver

Send all messages in OutBox of all accounts.

Sending messages



Receive All

Receive all messages from your mail server including the read messages.

This command can be used only when the "Delete Remote Mail When Received" option in the "Accounts"

preference is not checked.

Receiving messages



Check All Accounts

Check all the accounts you have defined one after another, and collect all unread messages.



Remote Mailbox

Retrieve information about the messages on the POP server and list them up.

You can select items and mark them as 'Receive', 'Receive&Del', 'Delete', or 'Read/Unread'. When you 

push 'OK', those commands will be processed.

'Read/Unread' is only effective when you have unchecked 'Delete Read Mail on Server' in the 'Accounts' 

property.



Clean up Server

Delete all the read messages on your mail server.

This command can be used only when the "Delete Remote Mail When Received" option in the "Accounts"

preference is not checked.

Receiving messages



Compose

Open the compose window to compose new message.

Sending messages



Reply

Open the compose window to reply to the selected message. This command only replies to the sender of 

the message. If you would like to reply to the people who are listed in the Cc and To fields, use Reply All 

command

Sending messages



Reply All

Open the compose window to reply to the selected message. This command replies not only to the 

sender but also to the people who are listed in the Cc and To fields except you.

Sending messages



Forward

You can forward incoming messages to another person by the "Forward" command.
The forwarding command has three different mode which you can select when selecting the forward 
command.

First one, you can send the forwarding message "from you" so that the receiver can receive this message
as the message sent from you. "From:" field shows up your address and "To:" field shows up the 
receiver's address. The receiver will reply of the message to you

In other two mode, the forwarded message shows up original "From" , "To" field, so you should be careful 
that if the person who got the forwarded mail replied to the message by the mailer which is unconscious 
of the "Resent-From" header, the reply mail will go to the original sender.
If you select "Redirect", the forwarding message has no "Fw:" prefix on the subject and original message 
will be sent. It would be useful when you would like to send the message which you have received 
somewhere else to your permanent mail address, or you would like to forward the message to whom is 
supposed to treat the message in your company.

With Becky!, you can choose the address who is supposed to receive the reply message for the 
forwarded mail by regarding the "Resent-From" and the other "Resent-" headers.

Sending messages



Delete

Delete the currently selected messages in the list pane.



Edit Message

Allow the user to edit messages.



Print

Print the selected message.



Print Preview

Show the print preview image of the message.



Receive From Backup Logs

If you checked 'Leave Backup Logs' option in the 'Receive ' property, incoming messages are saved to 

another file whose file format is 'YYYYMMDD.bkl' (YYYYMMDD is today's date).

You will be able to reload the messages which you have received on a certain day.



Exit

Exit the application.



Send

Send this message immediately

Sending messages 



Save to OutBox

Save this message into OutBox so that you can send them all by "Deliver" command.

Sending messages 



Save to Draft Box

Save this message into Draft Box so that you can polish it later.

Sending messages 



Reminder

Save this message as Reminder, a message which will be delivered to you at specified date.

Sending messages 



Load Template

Load a template message which you have saved before.

Sending messages 



Save Template

Save this message as a template which you can reuse it as the fixed-form.

Sending messages 



Close

Close the composing window.

If you wrote a message and did not send it yet, you are warned before closing.



Address Book

Open address book and select addresses to send mail.



Add the Sender to Address Book

Add the address of the sender of the selected message.



Header Information

Show the complete header information for the selected message.



EUC to SJIS

Convert the Japanese EUC message to SJIS message.

If the message is not a valid EUC text, you are asked whether you force to convert. If you force it, you 

cannot get back original message anymore. So, be careful.



SJIS to EUC

Convert the Japanese Shift JIS message to EUC message.

If the message is not a valid SJIS text, you are asked whether you force to convert. If you force it, you 

cannot get back original message anymore. So, be careful.



Filtering

Move particular incoming messages to particular folders according to the Filtering definition.

If "Auto Filtering" is ON, those messages are automatically delivered, but if that switch is off or you 

change the definition of the filtering, use this command to filter all the messages in the Inbox immediately.

See "Filter" definition.



Filtering Manager

Define the filter setting for the current account.

Filtering Manager Dialog



Export

Write the selected mail items into a file in various way.



Export Dialog

Export File Name Specify the name of the output file. Existing file will be overwrited.

[No]Separator Specify if you would like to add a separator string for each mail items.

Insert Separator at Top of Text

Specify if you would like to add a separator at the top of the text

One File for One Item

Specify if you would like to write one item as one file. If it is specified, the extension

of the export file name will be ignored and the file number will be added as an 

extension for each file such as "file.1", "file.2" ...



Reorganize

Becky! usually manage mail items in date-descendant order. But after you move or copy mail items to 

other folders, those order is disordered.

In this case, use this command to reorganize the order of the mail items.

They will be sorted by "Sent date" not "Received date" and the time differences are ignored , so they may 

not be in the correct order.



Mark as Read

Mark the selected messages as read.



Mark as Unread

Mark the selected messages as unread.



Colored Label

Change color of each message item so that you can easily find the message later.

You can also call this function by right clicking the envelope icon in the item window.



New Letter Folder

Create new letter folder. If you locate cursor at root or system folder (InBox, OutBox, and Trash Box), the 

new folder will be a child of the root. If you locate cursor at the folder you created, the new folder will be a 

child of the folder.

After creating folder, you can change the folder name.



Explore Attachment Folder

Open the Windows Explorer in the attachment folder. Attachment folder stores files in the messages 

which you have received.



Switch User

Switch the account to the other one.

You can manage multiple account up to ten.

Accounts preference



Address Book Dialog

You can input E-mail addresses using the address book.

The list at the upper side is the list of addresses and groups. The addresses are belongs to each address 
group. You can make multiple address groups as well as e-mail addresses.
Double clicking the address group is to select the group as a current address group. Only the addresses 
which belongs to the current address group are shown in the list.
You can switch a current address group in the right mouse button menu as well.

Double clicking an address is to input to To, Cc, or Bcc list. The address will be input where the square 
button is pushed.
You can click each To, Cc, or Bcc button to input addresses instead of double clicking.
Triple clicking means clicking OK button after double clicking.

Details on the window items

New Addr Add new address to the current group
New Grp Add new group
Properties Show the properties of the focused address or group
Select All Select all the items
Delete Delete selected items
Sort Show the sort mode of the address list (You can sort items by clicking each header of

the list.)
Up/Down Move the selected item up or down
To Input selected items to To field
Cc/Bcc Input selected items to Cc or Bcc field
<<Delete Delete a selected address from To, Cc, or Bcc list
<<Clear Delete all the addresses from the To, Cc, or Bcc list
Input Address Input address or nickname directly
Set To Mail(OK) Set the input addresses to a composing window
Close(Cancel) Close the window



Properties of Address

Name Specify the real name for the address. It is shown as
"Tomohiro Norimatsu <carty@kagi.com>" in the To or Cc field.

Mail Address Specify the e-mail address.

Nick Name Specify a nick name for this address. Nick name works like as follows:
If you specify a nickname "tomo" for "Tomohiro Norimatsu 
<carty@kagi.com>", you will get entire address by simply typing "tomo" in
the "To" field and hit Enter or Tab key.

Comments Comments for the address. It shows up at the right of the address list.

Related URL Specify related URLs. You will jump to specified site from the right button 
menu when you are selecting the address in the address list.
You can specify multiple URLs by delimitering by comma, though 
(therefore) you can't specify a URL which contains comma.

PGP User ID Specify particular PGP user ID for this address if you need. As default, an e-
mail address enclosed by <> is used for specifying a PGP user in Becky!.



Spell Check

You can use spell checking capability on the compose window if you have Microsoft® Office 95 installed.

CSAPI(Common Spelling API), Becky! uses for spell checking, is not officially supported by Microsoft®    

however. So, you might not use spell checking on occasion even if you have installed Office95. If so, let 

me know please.

If you select text, inside of the selection is checked. If not, entire text is checked.

When a suspicious word is found, the dialog box appears and suggests other candidates. You can select 

Ignore, Ignore all, change, change all, add (to the user dictionary) options.

User dictionary is created in the root mail folder. The name is "BKcustom.dic". This is a plain text file. If 

you want to delete or add words in the user dictionary, you can edit the file directly.

"BKexc.dic" is also found in the same folder. It, however, is not used currently.



Managing mailing lists

ML('Mailing list') is a useful communication tool for small special interested 
group to exchange information with its members. Recently, some kind of 
'Online Magazines' take the form of    ML. If you live in cyberspace, you will 
get many chances to subscribe or unsubscribe MLs. But MLs force users little 
complicated procedure; each of them has different mail address and 
command syntax may vary.
You will be able to manage those complicated information in one dialog box 
by using 'Mailing Lists Manager'.

Mailing Lists Manager dialog

New add new ML.

Edit edit the information of the selected ML.

Delete delete the information of the selected ML.

Copy duplicate the information of the selected ML.

Subscribe Open the mail to subscribe the ML.

Unsubscrib(e) Open the mail to unsubscribe the ML.

Commands Open the mail to send commands to the ML.

Web Sites Open WWW browser and see the site related to the ML.

Details Open a text editor to see the detailed information on the ML.

Post Post mail to the ML.

To Admin Send mail to the administrator of the ML.

Using Mailing Lists Manager

If you subscribe a certain ML, you will receive a 'Welcome' message from the ML.

This mail contains every important information to use this ML.

Then follow the procedure:

1) w entry.

2)    the ML.



Name Name of the ML.

Command To the mail address to send commands.

Use following buttons to register commands for the ML.

Subscribe Subscribe command for the ML.

. g. (for majordomo system)

Subject: (leave blank)

Body: subscribe ml-name

end

Unsubscribe Unsubscribe command for the ML

Others Other command for the ML such as 'help'.

Post To Posting address for the ML.

Admin's e-mail e-mail address of the administrator of the ML. (if any)

Web Site URL for the related Web site for the ML. (if any)

Then click OK.

1) ught up.

1) save it.

1)    things.

n Subscribe / Unsubscribe to the registered ML in one action.

n Refer information on registered ML quickly.

n Relate a certain mail folder with a registered ML.

Next, I will explain about the third, 'Relating ML with a folder'.

Relating a mailing list with a mail folder

You might want to create a new folder to store all mail for a mailing list. Otherwise, you will be confused 

because all messages for multiple mailing lists will come into one Inbox.

1) e folder name may be 'Blahblah ML'.

2) on menu.

3) submenu.



1)elated mailing list here. Then click 'OK'.

1)tically.

2)ng should be OK generally. But you can choose another header or string so that the mail for the ML will 

be certainly delivered.(You can configure further settings for filtering by using 'Filtering Manager' in 

'Tool' menu)

Now you can use 'Post' or other commands for the ML in the right button menu.



Spell checking

You can use spelling checker in the composing window.
The entire text or the selection will be checked.

You can check spells in American English, British English, or the both by configuring the options in the 
"Misc." property.
Although there is no user interface to maintain the user dictionary, it is a plain text file stored in the mail 
box directory so that you can edit it using a text editor.
Open the "BkIgn.TLX" file by a text editor like notepad or Dana, edit, and save. Be careful not to remove 
the first line in the text which is like this:

#LID 1033 1 86



Using Templates

Templates allow you to create messages and responses automatically formatted the way that you want 
them--for a mailing list assigned to its own folder, for example. Think of a template as the outline for a 
form letter--complete with your choice of header lines, boilerplate text, and information copied from the 
original message. The Tools|Options|Account|Misc. dialog box allows you to specify separate templates 
for new messages, replies to messages, and forwarded messages. The Folder Properties dialog box then
allows you to override any or all of these for particular folders.

Creating a template

The process starts the same way as writing a regular message. Choose "Compose" to open the 
Compose window and type your stock message.

Start by adding Subject:, Cc:, and any other header lines that you wish to always appear--Reply to: with 
your own name for messages to a mailing list or Cc: (or Bcc:) to your boss for business correspondence, 
for example.

To add flexibility, refer back to the original message with the following "macro symbols" or place holders, 
which the software automatically fills in when it loads the template. (These are also available for use in 
the stock intro to regular replies. See the Create tab under Tools|Options.)

%f The data portion of the From: line from the original message, the one that you are 
replying to or forwarding.

%t The data portion of the To: line from the original message.

%d The data portion of the Date: line from the original message or, for a new message, the 
date and time at which you (or the mail reader) loaded the template.

%D The data from %d converted to local time and formatted to the standard date format that 
you have specified with the Windows' control panel.

%i The data portion of the Message-Id: line from the original message

%s The data portion of the Subject: line from the original message.

%n The name portion of the From: line from the original message.

%a The mail address portion of the From: line from the original message.

%h{header} The data portion of the specified header line--%h{X-mailer}, for example.

%m The original message verbatim.

%M The original message marked with the citation prefix string.

%A Your email address.

%N Your name.

%1 to %0 Signature No. 1 to 20.

%% % itself



When this outline is complete, save it with the "Save Template" command. You
may omit the "tml" extension, but you cannot substitute another.

Quick example:

Hi %n,

On %d
%f wrote:

%M

%1

Saving the above template and specifying it as the account's Reply
Template produces a response similar to the following for a message from
me.

Hi Tomohiro Norimatsu,

On Wed, 24 Jul 1996 14:56:24
Tomohiro Norimatsu <carty@kagi.com> wrote:

>Hi,
>What's up?

--
Johnny B. Good <john@blahblah.com>
Blah-Blah technology Inc.

Editing a template

Choose "Compose" to open the Compose window.

Hold down the Shift key and choose the "Load Template" command. Note that the Shift key is to prevent 
the automatic conversion of macro symbols.

Edit and save the template using the procedures for creating one.

Loading a template

If you have already opened the Compose window, use the "Load Template" command.

Otherwise, hold down the Shift key when you select the "Compose", "Reply", or "Forward" command.



Command line options

Becky! supports the following command line options.

Rebecca /A mail@address Open the compose window for the address. "Rebecca 
mailto:mail@address" also works fine.

Rebecca filename [filename...] Open the compose window with opening the specified files. If the 
files are text files, they are loaded as a message, otherwise are 
added as attachments.



FAQ and Tips

How can I see the help for each command?

Click the rightmost tool button with a question mark icon. The figure of the mouse cursor is changed. 
Then select any tool button or menu item.

How can I turn off the annoying control characters such as CRLF and Tabs in the editor?

You have an option for turning them off in the 'View' property in the 'Preferences'.

The word wrapping is fine. But when I paste strings, The lines are not wrapped automatically. How can I 
do with it?

You need to select the text you would like to wrap and use 'Reformat' command. It is available on the 
tool bar (6th button from the right).

How can I use Becky! as a standard mailer for MS Internet Explorer 3.0?

To make it the default email program for MSIE, you need to configure
the file type as follows:

1) Run 'Explorer'. (the Windows' Explorer, not the Internet Explorer)
2) Select 'Options' in the 'View' menu.
3) Select 'File Types' Tab.
4) Select 'URL:MailTo Protocol' in the list and click 'Edit' button.
5) Select 'open' in the 'Action' list and click 'Edit' button.
6) Input Becky!'s full path name in the 'Application used to perform action' field.
e.g.
C:\Program Files\RIMArts\Rebecca\Rebecca.EXE
7) Then click 'OK'.

How can I use Becky! as a standard mailer for Netscape Navigator?

You will need to use a "Web Expander" utility. It is a shareware which is available at
http://www.st.rim.or.jp/~tezz-k/

How can I configure the print settings such as margins and footers?

You can configure the print settings by editing Rebecca.INI file.
Add the following description under the [Settings] section.

# Footer note. &p represents the page no.
Footer=- &p -

# Footer alignment. 0: Left, 1: Center, 2:Right
FootAlign=1

# Header note.
Header=
HeadAligh=

# Margin. (mm co-ordination)
PrintTop=5
PrintBottom=5



PrintLeft=5
PrintRight=5

I'd like to read unread mail continuously.

Use space key. :-)

The mail view is too narrow, I'd like to read mail in a larger window.

You can maximize and restore the view window by double clicking the 'middle bar' or hitting 
Ctrl+Enter key.

What is the 'middle bar'?

The grey area at the middle of the main window which shows 'Subject', 'Date', etc.

I would like to use the same mail folders by different mail accounts.

Select the same 'Mail Box' number in the 'Accounts' property. The 'Mail Box' number is assigned to 
the mail account number as default.

When I look for help in the find option, I get an error "Unable to display the find tab. (177)".

Sorry, it is a known bug which I have not found the way to solve it.



About the registration

Becky! is a shareware: distribution and trial are free of charge.
If you want to continue to use this software, please purchase a license.
Trial period is up to 30 days.

If you register ...

- You will not see the shareware notification dialog on startup.
- You will be notified the major version up of Becky! via E-mail.
- You will be qualified to upgrade Becky! without any additional fee when new version is released.
- You will receive information on the other products, both free software and shareware, of RimArts, Inc.

Please check before the registration

- You MUST have an E-mail address.

Without an E-mail address, you will not receive a registration pass code.
"E-mail address" here means one which can receive Internet mail.
If you are a member of a network service which provides Internet mail address, your E-mail address 
would be

          YOURID@blahblah.net
          YOURID@blahblah.com
          ...

- You MUST have one of the payment methods which are supported by Kagi.

Credit Card: Visa, Mastercard, American Express.
Check or Money Order
Cash (It, however, is not a good idea because of the security reason and sending cash is prohibited in 

some country's law.)
First Virtual: see http://www.fv.com
Invoice

- Please make sure Becky! works fine on your machine.

    Becky! is programmed to work with most of machines. But sometimes it might not work well for some 
reasons; the problem of your modem driver, mail server's implementation of your Internet provider, 
some conflict with your system environment, etc.

    PLEASE MAKE SURE BECKY! WORKS FINE ON YOUR MACHINE AND WITH YOUR INTERNET 
PROVIDER BEFORE YOU SEND MONEY.

    Of course, we will do the best to fix the problem if you report to us. But your registration is not 
refundable in any way.

Price

40 US$ for one license.

Volume discount

Volume discount will be applied according to the number of licenses.
Please read below carefully if you want to purchase multiple licenses. Once your payment is 
processed, it is not refundable even if you specified inappropriate number of licenses.



minimum number    unit price(US$)
                5              35
              10              30
              15              25
              20              20
              40              15
              60              12
              80              11
            100              10
            200                9
            300                8
          1000                5

The price for 20 licenses is 20$ * 20 = $400, for 40 licenses is 15$ * 40 = $600.
Selecting minimum number is most reasonable. for example, if you want 18 licenses, it is not a good 
idea to purchase exactly 18. Because 18 is greater than 15 but less than 20, so $25 unit price is 
applied. It is paradoxical but total amount is $450 which is more expensive than $400 for 20 
licenses!

How to register

- Run REGISTER.EXE. (REGISTER.EXE is included in the Becky!'s package.)
    You can also run REGISTER.EXE from the startup dialog clicking "Order To Kagi" button.

- Fill out the information such as your name, E-mail address, number of licenses you are purchasing, 
and payment method.

    For more details, see REGISTER.HLP.

- Send the output of REGISTER.EXE to Kagi (sales@kagi.com).
    via E-mail, postal mail or fax.
    Please do NOT send it to me. Only "Kagi <sales@kagi.com>" can process the payment.
    If you want to use Becky! to send the mail, please do NOT check "Use MAPI enabled mailer" 

option. Because Becky! doesn't support MAPI currently.
(REGISTER.EXE is an independent software product created by Grzegorz Kochaniak. It is not made 
for dealing with Becky!.)

- You will receive a confirmation of the payment and a registration pass code via E-mail. Generally, It 
takes less than a week to receive it.

    Fax order takes a few days more.
    Long weekend, heavy network traffic, etc., may cause a several days delay.
    If you do not receive a reply in two weeks, please contact me. (carty@rimarts.co.jp)

- Run Becky! and click "I have paid and got a pass code." button on the startup dialog.
    You can also register from "User Registration" in the "Help" menu.

- Fill out the information: your name, registration pass code and E-mail address, and click "OK".

For more information about the registration through Kagi,
see "http://www.kagi.com/".
And if you have any problem through the registration procedure, feel
free to contact me. (carty@rimarts.co.jp)

KAGI IS A PAYMENT PROCESSING SERVICE. THEY DO NOT DO ANY TECHNICAL SUPPORT 
FOR OUR PRODUCT. PLEASE DO NOT SEND ANY MAIL REGARDING OUR PRODUCT TO KAGI, 
BUT TO <carty@rimarts.co.jp>.



------------------------------------------------------------------------
- Kagi is the secure and convenient shareware payment processing service. "http://www.kagi.com/".

- Register for Windows (REGISTER.EXE) is written by Grzegorz Kochaniak.



About PGP

Becky! has an easy-to-use PGP front end capability. It, however, is assumed that you already have 

installed PGP program and your system is configured correctly. Becky! never have any encrypting or 

decrypting code inside.

Background

PGP is divided to two versions; US version and International version.

It is free, but it is illegal to download and use US version outside USA and illegal to download and 

use International version inside USA.

For that reason, PGP has a sort of complicated background. So, please obtain and use PGP program 

totally on your own responsibility. Read all the instructions and documents which is included in the 

PGP archive very carefully before use it.

I can't give further information on PGP itself. If you are interested in it, please find appropriate information 

for your country.

Becky's PGP functions

Composing (in the Tool menu)

Signature Sign an outgoing message with your secret key. Do not modify the text after you 

add a signature. (PGP -sta)

Encrypt Encrypt an outgoing message for the recipients specified in To, Cc, and Bcc field.

You need to have public keys for those recipients in your public key ring. (PGP -

ea)

Sign and Encrypt Sign and encrypt an outgoing message. (PGP -esa)

Attach Public Key Extract a public key of specified PGP user from your public key ring and paste it 

into text. (PGP -kxa)

Receiving ('PGP processing' command in the Tool menu)

Decrypt

Check signature

Add public key

(All three process can be done by single 'PGP processing' command.)



Sending Voice E-mail

Becky! supports sending voice message in GSM6.10 format of WAV file. This format is good for sending 

voice message through Internet because it is very small (2k/sec) and the quality is good enough. But, 

some platform other than Windows95/NT4.0 might not support playing back this format of WAV file. So, 

please be careful when you are sending voice message from Becky!.

Recording

- Select 'Record Voice' command in the 'Tools' menu in the Compose window. This command is also 

available as a tool button at 4th from the left.

- Click 'Record' button to start recording. Speak something through a microphone connected to your 

computer. 

- Click 'OK'. Then the voice file is attached to your message.



View HTML mail

Becky! can display HTML messages in its message window. You need MS Internet Explorer 3.0 or higher 

installed to enable this capability because Becky! uses ActiveX components which are included in MSIE. 

So, even if you do not use MSIE for your default browser, I recommend install it on your system.

You will see the HTML messages either in an inline window or a separated window.

The message which is sent as text/html is displayed inline but sent as multipart is displayed in a 

separated window because the multipart message might include some other information besides the html 

text itself.

In some environment, you might encounter a problem when you select a HTML mail.

Sometimes, you can fix the problem by the following procedure.

- Set MSIE3.0 as your default browser.

or

- Reinstall MSIE3.0.

I don't know the reason but I've heard some other problems (no relation with Becky!) happen in some 

situations in the environment which Netscape Navigator and MS Internet Explorer coexist.

They are having a fight or something, I guess. ;-)




